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         Introduction

         
            Welcome to PowerPoint 2007 For Dummies, the book written especially for those who are lucky enough to use this latest and greatest version of PowerPoint and want to find out just enough to finish that presentation that was due yesterday.

         Do you ever find yourself in front of an audience, no matter how small, flipping through flip charts or shuffling through a stack of handwritten transparencies? You need PowerPoint! Have you always wanted to take your notebook computer with you to impress a client at lunch, but you don’t know what to do with it between trips to the salad bar? You really need PowerPoint!

         Or maybe you’re one of those unfortunate folks who bought Microsoft Office because it was such a bargain and you needed a Windows word processor and spreadsheet anyway, and hey, you’re not even sure what PowerPoint is, but it was free. Who can resist a bargain like that?

         Whichever way, you’re holding the perfect book right here in your formerly magic-marker-stained hands. Help is here, within these humble pages.

         This book talks about PowerPoint in everyday — and often irreverent — terms. No lofty prose here; the whole thing checks in at about the fifth-grade reading level. I have no Pulitzer expectations for this book. My goal is to make an otherwise dull and lifeless subject at least tolerable, and maybe even kind of fun.

         
            About This Book

            This isn’t the kind of book that you pick up and read from start to finish as though it were a cheap novel. If I ever see you reading it at the beach, I’ll kick sand in your face. This book is more like a reference — the kind of book you can pick up, turn to just about any page, and start reading. It has 26 chapters, each one covering a specific aspect of using PowerPoint — such as printing, animating your slides, or using clip art.

            Each chapter is divided into self-contained chunks, all related to the major theme of the chapter.

            For example, the chapter on using charts contains nuggets like these:

            
               	[image: bullet]	Understanding charts

               	[image: bullet]	Adding a chart to your presentation

               	[image: bullet]	Pasting a chart from Excel

               	[image: bullet]	Changing the chart type

               	[image: bullet]	Working with chart data

            

            You don’t have to memorize anything in this book. It’s a need-to-know book: You pick it up when you need to know something. Need to know how to create an organization chart? Pick up the book. Need to know how to override the Slide Master? Pick up the book. After you find what you’re looking for, put it down and get on with your life.

         

         
            How to Use This Book

            This book works like a reference. Start with the topic that you want to find out about: To get going, look for it in the Table of Contents or in the Index. The Table of Contents is detailed enough that you should be able to find most of the topics that you look for. If not, turn to the index, where you find even more detail.

            When you find your topic in the Table of Contents or the index, turn to the area of interest and read as much or as little as you need or want. Then close the book and get on with it.

            This book is loaded with information, of course, so if you want to take a brief excursion into your topic, you’re more than welcome. If you want to know all about Slide Masters, read the chapter on templates and masters. If you want to know all about animation, read the chapter on animation. Read whatever you want. This is your book — not mine.

            On occasion, this book directs you to use specific keyboard shortcuts to get things done. When you see something like Ctrl+Z, this instruction means to hold down the Ctrl key while pressing the Z key and then release both together. Don’t type the plus sign.

            Sometimes I tell you to use a command that resides on the new ribbon interface like this: choose Home⇒Editing⇒Find. That means to click the Find button, which you’ll find in the Editing group on the Home tab.

            Whenever I describe a message or information that you see on-screen, it looks like this:

            

            
               Are we having fun yet?

            Anything you’re instructed to type appears in bold like so: Type a:setup in the Run dialog box. Type exactly what you see, with or without spaces.

            Another nice feature of this book is that whenever I discuss a certain button that you need to click in order to accomplish the task at hand, the button appears either in the margin or in a helpful table that summarizes the buttons that apply to a particular task. This way, you can easily locate it on your screen.

         

         
            What You Don’t Need to Read

            Some parts of this book are skippable. I carefully place extra-technical information in self-contained sidebars and clearly mark them so that you can give them a wide berth. Don’t read this stuff unless you just gots to know. Don’t worry; I won’t be offended if you don’t read every word.

         

         
            Foolish Assumptions

            I make only three assumptions about you:

            
               	[image: bullet]	You use a computer.

               	[image: bullet]	It’s a Windows computer — not a Macintosh. 

               	[image: bullet]	You use or are thinking about using PowerPoint 2007.

            

            Nothing else. I don’t assume that you’re a computer guru who knows how to change a controller card or configure memory for optimal use. These types of computer chores are best handled by people who like computers. Hopefully, you are on speaking terms with such a person. Do your best to stay there.

         

         
            How This Book Is Organized

            Inside this book are chapters arranged in six parts. Each chapter is broken down into sections that cover various aspects of the chapter’s main subject. The chapters have a logical sequence, so it makes sense to read them in order if you want. But you don’t have to read the book that way; you can  flip it open to any page and start reading.

            Here’s the lowdown on what’s in each of the five parts:

            
               Part I: Basic PowerPoint 2007 Stuff

               In this part, you review the basics of using PowerPoint. This is a good place to start if you’re clueless about what PowerPoint is, let alone how to use it.

            

            
               Part II: Creating Great-Looking Slides

               The chapters in this part show you how to make presentations that look good. Most important are the chapters about themes (Chapter 9), and masters and templates (Chapter 11). Get the theme, template, and masters right, and everything else falls into place.

            

            
               Part III: Embellishing Your Slides

               One of the nifty new features of PowerPoint 2007 is the Insert tab on the Ribbon. It’s loaded with things you can insert into your presentations. The chapters in this part explore the various goodies to be found here, such as pictures, clip art, charts, SmartArt objects, sounds, movies, tables, ginsu knives, and more!

            

            
               Part IV: Working with Others

               The chapters in this part show you how to use PowerPoint’s many collaboration features, such as using revision tracking tools, creating slide libraries, and working with SharePoint. 

            

            
               Part V: The Part of Tens

               This wouldn’t be a For Dummies book without lists of interesting snippets: ten PowerPoint commandments, ten tips for creating readable slides, ten ways to keep your audience awake, ten things that often go wrong (my all-time favorite), and ten new features for 2007.

            

         

         
            Icons Used in This Book

            As you’re reading all this wonderful prose, you occasionally see the following icons. They appear in the margins to draw your attention to important information. They are defined as follows:

            

            
               [image: ]
            

            	Watch out! Some technical drivel is just around the corner. Read it only if you have your pocket protector firmly attached.

            

            
               [image: ]
            

            	Pay special attention to this icon — it tells you that some particularly useful tidbit is at hand, perhaps a shortcut or a way of using a command that you might not have considered.

            

            
               [image: ]
            

            	Danger! Danger! Danger! Stand back, Will Robinson!

            

            
               [image: ]
            

            	Did I tell you about the memory course I took? Paragraphs marked with this icon simply point out details that are worth committing to memory.

         

         
            Where to Go from Here

            Yes, you can get there from here. With this book in hand, you’re ready to charge full speed ahead into the strange and wonderful world of desktop presentations. Browse through the Table of Contents and decide where you want to start. Be bold! Be courageous! Be adventurous! Above all else, have fun! 

         

      

      

   
      
         Part I

         Basic PowerPoint 2007 Stuff

                           
            [image: ]
         

         In this part . . .

         
            O nce upon a time, the term presentation software meant poster board and marker pens. Now, however, programs such as Microsoft PowerPoint enable you to create spectacular presentations on your computer.

         The chapters in this part compose a bare-bones introduction to PowerPoint. You find out exactly what PowerPoint is and how to use it to create simple presentations. More-advanced stuff, such as adding charts or using fancy text fonts, is covered in later parts. This part is just the beginning. As a great king once advised, it is best to begin at the beginning and go on until you come to the end; then stop.

         

      

   
      
         Chapter 1

         Welcome to PowerPoint 2007

         In This Chapter

         
            [image: bullet]	Introducing PowerPoint

            [image: bullet]	Firing up PowerPoint

            [image: bullet]	Making sense of the PowerPoint screen and the Ribbon

            [image: bullet]	Creating a presentation

            [image: bullet]	Viewing presentation outlines

            [image: bullet]	Saving and closing your work

            [image: bullet]	Retrieving a presentation from the hard drive

            [image: bullet]	Getting out of PowerPoint

         

         
            This chapter is a grand and gala welcoming ceremony for PowerPoint 2007, the all-new and thoroughly revamped version of Microsoft’s popular slide- presentation program.

         This chapter is sort of like the opening ceremonies of the Olympics, in which all the athletes parade around the stadium and people make speeches in French. In much the same way, this chapter marches PowerPoint 2007 around the stadium so you can get a bird’s-eye view of what the program is and what you can do with it. I might make a few speeches, but not in French (unless, of course, you’re reading the French edition of this book).

         
            What in Sam Hill Is PowerPoint?

            PowerPoint is a program that comes with Microsoft Office (although you can buy it separately, as well). Most people buy Microsoft Office because it’s a great bargain: You get Word, Excel, and Outlook all together in one inexpensive package. And PowerPoint is thrown in for good measure. Of course, depending on which edition of Office you buy, you might get other goodies as well, such as Access, Publisher, a complete set of Ginsu knives, and a Binford VegaPneumatic Power Slicer and Dicer (always wear eye protection).

            You know what Word is — it’s the world’s most loved and most hated word processor, and it’s perfect for concocting letters, term papers, and great American novels. Excel is a spreadsheet program used by bean counters the world over. Outlook is that program you use to read your e-mail. But what the heck is PowerPoint? Does anybody know or care? (And as long as I’m asking questions, who in Sam Hill was Sam Hill?)

            PowerPoint is a presentation program, and it’s one of the coolest programs I know. It’s designed to work with a projector to display presentations that will bedazzle your audience and instantly sway them to your point of view, even if you’re selling real estate on Mars, season tickets for the Mets, or a new Medicare plan to Congress. If you’ve ever flipped a flip chart, you’re going to love PowerPoint.

            Here are some of the many uses of PowerPoint:

            
               	[image: bullet]	Business presentations: PowerPoint is a great timesaver for anyone who makes business presentations, whether you’ve been asked to speak in front of hundreds of people at a shareholders’ convention, a group of sales reps at a sales conference, or your own staff or co-workers at a business meeting.

               	[image: bullet]	Sales presentations: If you’re an insurance salesperson, you can use PowerPoint to create a presentation about the perils of not owning life insurance and then use your laptop to show it to hapless clients.

               	[image: bullet]	Lectures: PowerPoint is also useful for teachers or conference speakers who want to back up their lectures with slides.

               	[image: bullet]	Homework: PowerPoint is a great program to use for certain types of homework projects, such as those big history reports that count for half your grade.

               	[image: bullet]	Church: People use PowerPoint at churches to display song lyrics on big screens so everyone can sing or to display sermon outlines so everyone can take notes. If your church still uses hymnals or prints the outline in the bulletin, tell the minister to join the 21st century.

               	[image: bullet]	Information stations: You can use PowerPoint to set up a computerized information kiosk that people can walk up to and use. For example, you can create a museum exhibit about the history of your town or set up a trade-show presentation to provide information about your company and products.

               	[image: bullet]	Internet presentations: PowerPoint can even help you to set up a presentation that you can broadcast over the Internet so people can join in on the fun without having to leave the comfort of their own homes or offices.

            

         

         
            Introducing PowerPoint Presentations

            PowerPoint is similar to a word processor such as Word, except that it’s geared toward creating presentations rather than documents. A presentation is kind of like those Kodak Carousel slide trays that your father used to load up with 35-mm slides of your family trip to the Grand Canyon. The main difference is that you don’t have to worry about dumping all the slides in your PowerPoint presentation out of the tray and onto the floor.

            Word documents consist of one or more pages, and PowerPoint presentations consist of one or more slides. Each slide can contain text, graphics,  and other information. You can easily rearrange the slides in a presentation, delete slides that you don’t need, add new slides, or modify the contents of existing slides.

            You can use PowerPoint both to create your presentations and to actually present them.

            You can use several different types of media to actually show your presentations:

            
               	[image: bullet]	Computer monitor: Your computer monitor, either a CRT monitor or an LCD, is a suitable way to display your presentation when you’re showing it to just one or two other people.

               	[image: bullet]	Computer projector: A computer projector projects an image of your computer monitor onto a screen so large audiences can view it.

               	[image: bullet]	Overhead transparencies: Overhead transparencies can be used to show your presentation using an overhead projector.

               	[image: bullet]	Printed pages: Printed pages allow you to distribute a printed copy of your entire presentation to each member of your audience. (When you print your presentation, you can print one slide per page, or you can print several slides on each page to save paper.)

               	[image: bullet]	35-mm slides: For a fee, you can have your presentation printed onto  35-mm slides either by a local company or over the Internet. Then, your presentation really is like a Kodak Carousel slide tray!

            

            
               Presentation files

               A presentation is to PowerPoint what a document is to Word or a worksheet is to Excel. In other words, a presentation is a file that you create with PowerPoint. Each presentation that you create is saved on the hard drive as a separate file.

               PowerPoint 2007 presentations have the special extension .pptx added to the end of their filenames. For example, Sales Conference.pptx and History Day.pptx are both valid PowerPoint filenames. When you type the filename for a new PowerPoint file, you don’t have to type the .pptx extension, because PowerPoint automatically adds the extension for you. Windows may hide the .pptx extension, in which case a presentation file named Conference.pptx often appears as just Conference.

               

               
                  [image: ]
               

               	Previous versions of PowerPoint saved presentations with the extension .ppt instead of .pptx. The x at the end of the new file extension denotes that the new file format is based on XML, a popular data format that makes it easier to exchange files among different programs. PowerPoint 2007 can save files in the old .ppt format, but I recommend you do so only if you need to share presentations with people who haven’t yet upgraded to PowerPoint 2007. (You can download a program called the Microsoft Office Compatibility Pack from www.microsoft.com that enables PowerPoint 2002 or 2003 to read and write files in .pptx format. This program enables you to share your .pptx files with people who haven’t yet upgraded.)

               PowerPoint is set up initially to save your presentation files in the My Documents folder, but you can store PowerPoint files in any folder of your choice on your hard drive or on any other drive. You can write a presentation to a CD-RW drive or to a removable USB flash drive if you want to take it home with you to work on or if you need to give it to other people so they can use it on their computers.

            

            
               What’s in a slide?

               PowerPoint presentations comprise one or more slides. Each slide can contain text, graphics, and other elements. A number of PowerPoint features work together to help you easily format attractive slides:

               
                  	[image: bullet]	Slide layouts: Every slide has a slide layout that controls how information is arranged on the slide. A slide layout is simply a collection of one or more placeholders, which set aside an area of the slide to hold information. Depending on the layout that you choose for a slide, the placeholders can hold text, graphics, clip art, sound or video files, tables, charts, graphs, diagrams, or other types of content.

                  	[image: bullet]	Background: Every slide has a background, which provides a backdrop for the slide’s content. The background can be a solid color; a blend of two colors; a subtle texture, such as marble or parchment; a pattern, such as diagonal lines, bricks, or tiles; or an image file. Each slide can have a different background, but you usually want to use the same background for every slide in your presentation to provide a consistent look.

                  	[image: bullet]	Themes: Themes are combinations of design elements such as color schemes and fonts that make it easy to create attractive slides that  don’t look ridiculous. You can stray from the themes if you want, but you should do so only if you have a better eye than the design gurus that work for Microsoft.

                  	[image: bullet]	Slide Master: The Slide Master is a special type of slide that controls the basic design and formatting options for slides in your presentation. The Slide Master includes the position and size of basic title and text placeholders; the background and color scheme used for the presentation; and font settings, such as typefaces, colors, and sizes. In addition, the Slide Master can contain graphic and text objects that you want to appear on every slide.

                  		You can edit the Slide Master to change the appearance of all the slides in your presentation at once. This helps to ensure that the slides in your presentation have a consistent appearance.

               

               All the features described in the previous list work together to control the appearance of your slides in much the same way that style sheets and templates control the appearance of Word documents. You can customize the appearance of individual slides by adding any of the following elements:

               
                  	[image: bullet]	Title and body text: Most slide layouts include placeholders for title and body text. You can type any text that you want into these placeholders. By default, PowerPoint formats the text according to the Slide Master, but you can easily override this formatting to use any font, size, style,  or text color that you want.

                  	[image: bullet]	Text boxes: You can add text anywhere on a slide by drawing a text box and then typing text. Text boxes allow you to add text that doesn’t fit conveniently in the title or body text placeholders.

                  	[image: bullet]	Shapes: You can use PowerPoint’s drawing tools to add a variety of shapes on your slides. You can use predefined AutoShapes, such as rectangles, circles, stars, arrows, and flowchart symbols. Alternatively, you can create your own shapes by using basic line, polygon, and freehand drawing tools.

                  	[image: bullet]	Illustrations: You can illustrate your slides by inserting clip art, photographs, and other graphic elements. PowerPoint also comes with a large collection of clip art pictures you can use, and Microsoft provides an even larger collection of clip art images online.

                  	[image: bullet]	Charts and 
                     diagrams: PowerPoint includes a new diagramming feature called SmartArt that enables you to create several common types of diagrams, including organization charts, cycle diagrams, and others. In addition, you can insert pie charts, line or bar charts, and many other chart types.

                  	[image: bullet]	Media clips: You can add sound clips or video files to your slides.

               

            

         

         
            Starting PowerPoint

            Here’s the procedure for starting PowerPoint:

            
               	
                  1.	
                  Get ready.

               		Light some votive candles. Take two Tylenol. Put on a pot of coffee. If you’re allergic to banana slugs, take an allergy pill. Sit in the lotus position facing Redmond, Washington, and recite the Windows creed three times:

               		
                  Bill Gates is my friend. Resistance is futile. No beer and no TV make Homer something something . . . 

               	
                  2.	
                  Click the Start button.

               		The Start button is ordinarily found in the lower-left corner of the Windows display. When you click it, the famous Start menu appears.  The Start menu works pretty much the same, no matter which version  of Windows you’re using.

            

            

            
               [image: ]
            

            
               		If you can’t find the Start button, try moving the cursor all the way to the bottom edge of the screen and holding it there a moment. With luck on your side, you see the Start button appear. If not, try moving the cursor to the other three edges of the screen: top, left, and right. Sometimes the Start button hides behind these edges.

               	
                  3.	
                  Point to All Programs on the Start menu.

               		After you click the Start button to reveal the Start menu, move the cursor up to the word All 
                  Programs and hold it there a moment. Yet another menu appears, revealing a bevy of commands. 

               	
                  4.	
                  Choose Microsoft Office
                  ⇒Microsoft Office PowerPoint 2007.

               		Your computer whirs and clicks and possibly makes other unmentionable noises while PowerPoint comes to life.

            

            

            
               [image: ]
            

            
               		If you use PowerPoint frequently, it might appear in the Frequently  Used Programs List directly on the Start menu so you don’t have to choose All Programs⇒Microsoft Office to get to it. If you want PowerPoint to always appear at the top of the Start menu, choose Start⇒All Programs⇒Microsoft Office. Then, right-click Microsoft Office PowerPoint 2007 and choose the Pin to Start Menu command.

            

         

         
            Navigating the PowerPoint Interface

            When you start PowerPoint, it greets you with a screen that’s so cluttered with stuff that you’re soon ready to consider newsprint and markers as a viable alternative for your presentations. The center of the screen is mercifully  blank, but the top part of the screen is chock-full of little icons and buttons  and doohickies. What is all that stuff?

            Figure 1-1 shows the basic PowerPoint screen in all its cluttered glory. The following list points out the more important parts of the PowerPoint screen:

            
               
                  
                     
                        	
                           
                              Figure 1-1: PowerPoint’s cluttered screen.

                        
                        	
                           [image: Figure 1-1: PowerPoint’s cluttered screen.]
                        
                     

                  
               

            

            
               	[image: bullet]	The Ribbon: Across the top of the screen, just below the Microsoft PowerPoint title, is PowerPoint’s main user-interface gadget, called the Ribbon. If you’ve worked with previous versions of PowerPoint, you were probably expecting to see a menu followed by one or more toolbars in this general vicinity. After meticulous research, Microsoft gurus decided that menus and toolbars are hard to use. So they replaced the menus and toolbars with the Ribbon, which combines the functions of both. The Ribbon takes some getting used to, but after you figure it out, it actually does become easier to use than the old menus and toolbars. The deepest and darkest secrets of PowerPoint are hidden on the Ribbon. Wear a helmet when exploring it.

               		Note that the exact appearance of the Ribbon varies a bit depending on the size of your monitor. On smaller monitors, PowerPoint may compress the Ribbon a bit by using smaller buttons and arranging them differently (for example, stacking them on top of one another instead of placing them side by side). 

               		For more information about working with the Ribbon, see the section “Unraveling the Ribbon,” later in this chapter.

            

            

            
               [image: ]
            

            
               		Although PowerPoint 2007 has done away with the menus, the keyboard shortcuts (technically called accelerators) that were associated with the PowerPoint 2003 menu commands still work. However, instead of pressing Alt and the accelerator key at the same time, you press them separately. For example, to call up the Open dialog box, press Alt, F, and O (for the old File⇒Open command). And to insert clip art, press Alt, I, P, and C (for the old Insert⇒Picture⇒Clip Art command).

               	[image: bullet]	The Office button (also known as the File menu): The big colorful  logo in the top-left corner of the PowerPoint window is called the Office button. You can click it to reveal the program’s one and only traditional menu. This is the place to come when you need to open or save files, create new presentations, print a document, and do other file-related chores.

               	[image: bullet]	Quick Access toolbar: Just to the right of the Office button is the Quick Access toolbar, also called the QAT for short. Its sole purpose in life is to provide a convenient resting place for the PowerPoint commands you use the most often.

               		Initially, this toolbar contains just four buttons: Save, Undo, Redo, and Print. However, you can add additional buttons if you want. To add any button to the QAT, right-click the button and choose Add to Quick Access Toolbar. You’ll also find a pull-down menu at the end of the QAT that lists several frequently used commands. You can use this menu to add these common commands to the QAT.

               	[image: bullet]	Current slide: Right smack in the middle of the screen is where your current slide appears.

               	[image: bullet]	Slides tab and Outline tab: To the left of the slide is an area that has two tabs, labeled Outline and Slides. The Slides tab shows thumbnail icons of your slides, and the Outline tab shows your presentation arranged as an outline. You can switch between the two tabs by clicking the tab you want to view. (For more information on working in Outline View, see Chapter 3.) The Slides tab, shown in Figure 1-1, shows little thumbnail images of your slides. 

               	[image: bullet]	Notes pane: Beneath the slide is a small area called the Notes pane, which you can use to add notes to your slides. For more information on using this feature, see Chapter 5.

               	[image: bullet]	Task pane: To the right of the slide is an area called the task pane. The task pane is designed to help you complete common tasks quickly. When you first start PowerPoint, the task pane isn’t visible, so you can’t see it in Figure 1-1. However, it will appear whenever it’s needed, and you’ll see plenty of examples of it throughout this book.

               	[image: bullet]	Status bar: At the very bottom of the screen is the status bar, which tells you the slide that is currently displayed (for example, Slide 1 of 1).

            

            

            
               [image: ]
            

            
               		You can configure the status bar by right-clicking anywhere on it. This reveals a list of options that you can select or deselect to determine which elements appear on the status bar.

            

            

            
               [image: ]
            

            	You’ll never get anything done if you feel that you have to understand every pixel of the PowerPoint screen before you can do anything. Don’t worry about the stuff that you don’t understand; just concentrate on what you need to know to get the job done and worry about the bells and whistles later.

         

         
            Unraveling the Ribbon

            The Ribbon is Microsoft’s new user-interface gadget for not just PowerPoint 2007, but also Word 2007, Excel 2007, and Access 2007. The Ribbon replaces the menus and toolbars found in earlier versions of these programs.

            Across the top of the Ribbon is a series of tabs. You can click one of these tabs to reveal a set of controls specific to that tab. For example, the Ribbon in Figure 1-1 (earlier in the chapter) shows the Home tab. Figure 1-2 shows the Ribbon with the Insert tab selected.

            
               
                  
                     
                        	
                           
                              Figure 1-2: The Ribbon with the Insert tab selected.

                        
                        	
                           [image: Figure 1-2: The Ribbon with the Insert tab selected.]
                        
                     

                  
               

            

            Initially, the Ribbon displays the following seven tabs:

            
               	[image: bullet]	Home: Basic commands for creating and formatting slides

               	[image: bullet]	Insert: Commands for inserting various types of objects on slides

               	[image: bullet]	Design: Commands that let you tweak the layout of a slide

               	[image: bullet]	Animations: Commands that let you add animation effects

               	[image: bullet]	Slide Show: Commands for presenting your slide show

               	[image: bullet]	Review: Commands for proofing and adding comments to your  presentations

               	[image: bullet]	View: Commands that let you change the view

            

            Besides these basic tabs, additional tabs appear from time to time. For example, if you select a picture, a Picture Tools tab appears with commands that let you manipulate the picture.

            The commands on a Ribbon tab are organized into groups. Within each group, most of the commands are simple buttons that are similar to toolbar buttons in previous versions of PowerPoint.

         

         
            The View from Here Is Great

            Near the right edge of the status bar is a series of three View buttons. These buttons enable you to switch among the various views, or ways of looking at your presentation. Table 1-1 summarizes what each View button does.

[image: Table 1-1]

         

         
            Creating a New Presentation

            When you first start PowerPoint, a new, blank presentation is created. The simplest way to create a new presentation is to start PowerPoint and then edit the blank presentation to your liking.

            An alternative is to use the Office⇒New command, which brings up the big dialog box shown in Figure 1-3. This dialog box presents several ways to create a new presentation:

            
               
                  
                     
                        	
                           
                              Figure 1-3: The New Presentation  dialog box.

                        
                        	
                           [image: Figure 1-3: The New Presentation dialog box.]
                        
                     

                  
               

            

            
               	[image: bullet]	Blank Presentation: Double-click Blank Presentation to start a new presentation from scratch.

               	[image: bullet]	Recently Used Templates: This section of the New Presentation dialog box lists templates you’ve recently used to create presentations. You can double-click any of these templates to create another presentation based on the template.

               	[image: bullet]	Installed Templates: Click this item to display a list of all the templates installed on your computer. When you create a presentation from a template, the presentation inherits various design elements (collectively called the theme) as well as pre-written content that’s stored in the template. 

               	[image: bullet]	Installed Themes: Click this item to display a list of all the themes installed on your computer. Creating a presentation from a theme is  similar to creating a presentation from a template, except that the  new presentation doesn’t contain any pre-written content.

               	[image: bullet]	My Templates: Double-click My Templates to bring up a separate dialog box that lets you locate templates to create your presentation from.

               	[image: bullet]	New 
                  From Existing: Double-click New From Existing to create a new presentation based on an existing one. Use this option if you want to create a presentation that is similar to one that you created previously.

               	[image: bullet]	Microsoft Office Online: Use this section of the dialog box to select a template from Microsoft’s online Web site. Note that the templates are arranged into categories, such as Agendas, Plans, and Presentations. 

            

            
               Zooming in

               PowerPoint automatically adjusts its zoom factor so that Slide View displays each slide in its entirety. You can change the size of your slide by using the zoom control slider that appears at the bottom right of the window.

            

            
               Editing text

               In PowerPoint, slides are blank areas that you can adorn with various objects. The most common type of object is a text object, a rectangular area that is specially designated for holding text. (Other types of objects include shapes, such as circles or triangles; pictures imported from clip art files; and graphs.)

               Most slides contain two text objects: one for the slide’s title and the other for its body text. However, you can add more text objects if you want, and you can remove the body text or title text object. You can even remove both to create a slide that contains no text.

               

               
                  [image: ]
               

               	Whenever you move the cursor over a text object, the cursor changes from an arrow to the I-beam, which you can use to support bridges or build aircraft carriers. Seriously, when the cursor changes to an I-beam, you can click the mouse button and start typing text.

               When you click a text object, a box appears around the text, and an insertion pointer appears at the spot where you clicked. PowerPoint then becomes like a word processor. Any characters that you type are inserted into the text at the insertion pointer location. You can press Delete or Backspace to demolish text, and you can use the arrow keys to move the insertion pointer around in the text object. If you press Enter, a new line of text begins within the text object.

               When a text object contains no text, a placeholder message appears in the object. For example, a title text object displays the message Click to add title. Other placeholders display similar messages. The placeholder message magically vanishes when you click the object and begin typing text.

               

               
                  [image: ]
               

               	If you start typing without clicking anywhere, the text that you type is entered into the title text object — assuming that the title text object doesn’t already have text of its own. If the title object is not empty, any text that you type (with no text object selected) is simply ignored.

               After you finish typing text, press Esc or click anywhere outside the text object.

               In Chapter 2, you find many details about playing with text objects, but hold your horses. You have more important things to attend to first.

            

            
               Adding a new slide

               When you first create a presentation, it has just one slide, which is useful only for the shortest presentations. Fortunately, PowerPoint gives you about 50 ways to add new slides to your presentation. You see only three of them here:

               
                  	[image: bullet]	On the Home tab, click the New Slide button in the Slides group.

                  	[image: bullet]	Press Ctrl+M.

                  	[image: bullet]	Right-click in the Slides or Outline tab on the left and then choose New Slide.

               

               In all three cases, PowerPoint adds a blank slide with a standard layout that includes a title and content area as shown in Figure 1-4. If you want to choose a different layout, click the Layout button in the Home tab to display the gallery of slide layouts. This pane enables you to pick from several different types of slide layouts. Just click the one that you want to use, and PowerPoint sets the new slide to the layout of your choosing.

               
                  
                     
                        
                           	
                              
                                 Figure 1-4: Choosing a slide layout.

                           
                           	
                              [image: Figure 1-4: Choosing a slide layout.]
                           
                        

                     
                  

               

               Each slide layout has a name. For example, the Title and Content layout includes a text object in addition to the title area. This is probably the layout you’ll use most. It’s the best format for presenting a topic along with several supporting points. For example, Figure 1-5 shows a typical bulleted list slide, in which a list of bulleted items describes signs that your son is headed down the road toward moral decay.

            

            
               Moving from slide to slide

               You have several ways to move forward and backward through your presentation, from slide to slide:

               
                  	[image: bullet]	Click one of the double-headed arrows at the bottom of the vertical scroll bar. Doing so moves you through the presentation one slide at  a time.

                  	[image: bullet]	Press the Page Up and Page Down keys. Using these keys also moves one slide at a time.

               

               
                  
                     
                        
                           	
                              
                                 Figure 1-5:  A typical text slide.

                           
                           	
                              [image: Figure 1-5: A typical text slide.]
                           
                        

                     
                  

               

               
                  	[image: bullet]	Use the scroll bar. When you drag the box in the scroll bar, a ToolTip appears to display the number and title of the current slide. Dragging the scroll bar is the quickest way to move directly to any slide in your presentation. 

                  	[image: bullet]	In the list of slides on the left side of the window, click the thumbnail for the slide that you want to display. If the thumbnails are not visible, click the Slides tab above the outline.

               

            

            
               Choosing a design

               In Parts II and III of this book, you’ll learn many different ways to create  great-looking slides. However, you don’t have to wait until then to apply  some basic style to your presentation. I’ve already mentioned that Office 2007 comes pre-loaded with a handful of professionally-designed themes that are designed to create polished presentations with just the click of a mouse. To apply one of these themes, just select the Design ribbon tab, then click the theme you want to apply in the Themes group. Figure 1-6 shows a presentation after a theme has been applied.

               
                  
                     
                        
                           	
                              
                                 Figure 1-6:  A slide  after a design  has been applied.

                           
                           	
                              [image: Figure 1-6: A slide after a design has been applied.]
                           
                        

                     
                  

               

               Due to space constraints, PowerPoint doesn’t display all of the available themes in the Ribbon at the same time. But just to the right of the themes is a scroll bar you can use to scroll through the themes. And the button at the bottom of the scroll bar brings up a gallery that displays all of the themes that come with Office 2007.

            

         

         
            Displaying Your Presentation

            When your masterpiece is ready, you can show it on the screen. Just follow these steps:

            
               	

            

            
               [image: ]
            

            
               	
                  1.	
                  Choose the Slide Show tab on the Ribbon and then click the From Beginning button in the Start Slide Show group (shown in the margin).

               		There are several shortcuts to this command. You can also start the show by pressing F5 or by clicking the Slide Show button, located with the other view buttons in the lower-right corner of the screen.

               	
                  2.	
                  Behold the first slide.

               		The slide fills the screen. Isn’t it pretty?

               	
                  3.	
                  Press Enter to advance to the next slide.

               		You can keep pressing Enter to call up each slide in the presentation. If you don’t like the Enter key, you can use the spacebar instead.

               		If you want to go back a slide, press Page Up.

               	
                  4.	
                  Press Esc when you’re done.

               		You don’t have to wait until the last slide is shown. If you find a glaring mistake in a slide or if you just get bored, you can press Esc at any time to return to PowerPoint.

            

            For the complete lowdown on showing your presentation, kindly turn to Chapter 6.

         

         
            Saving Your Work

            Now that you’ve spent hours creating the best presentation since God gave Moses the Ten Commandments, it’s time to save your work to a file. If you make the rookie mistake of turning off your computer before you’ve saved your presentation, poof! Your work vanishes as if David Copperfield were in town.

            Like everything else in PowerPoint, you have at least four ways to save a  document:

            
               	[image: bullet]	Click the Save button on the Quick Access toolbar.

               	[image: bullet]	Click the Office button and then choose Save.

               	[image: bullet]	Press Ctrl+S.

               	[image: bullet]	Press Shift+F12.

            

            If you haven’t yet saved the file to your hard drive, the magical Save As dialog box appears. Type the name that you want to use for the file in the Save As dialog box and click OK to save the file. After you save the file once, subsequent saves update the hard drive file with any changes that you made to  the presentation since the last time you saved it.

            Also note that after you save a file for the first time, the name in the presentation window’s title area changes from Presentation to the name of your file. This is simply proof that the file has been saved.

            

            
               [image: ]
            

            	Keep the following tips in mind when saving files:

            
               	[image: bullet]	Put on your Thinking Cap when assigning a name to a new file. The filename is how you can recognize the file later on, so pick a meaningful name that suggests the file’s contents.

               	[image: bullet]	Don’t work on your file for hours at a time without saving it. I’ve learned the hard way to save my work every few minutes. After all, I live in California, so I never know when a rolling blackout will hit my neighborhood. Get into the habit of saving every few minutes, especially after making a significant change to a presentation, such as adding a covey of new slides or making a gaggle of complicated formatting changes. 

            

         

         
            Opening a Presentation

            After you save your presentation to your hard drive, you can retrieve it later when you want to make additional changes or to print it. As you might guess, PowerPoint gives you about 2,037 ways to accomplish the retrieval. Here are the three most common:

            
               	[image: bullet]	Click the Office button and then choose the Open command.

               	[image: bullet]	Press Ctrl+O.

               	[image: bullet]	Press Ctrl+F12.

            

            All three retrieval methods pop up in the Open dialog box, which gives you a list of files to choose from. Click the file that you want and then click OK or press Enter.

            The Open dialog box has controls that enable you to rummage through the various folders on your hard drive in search of your files. If you know how to open a file in any Windows application, you know how to do it in PowerPoint (because the Open dialog box is pretty much the same in any Windows program).

            If you seem to have lost a file, rummage around in different folders to see whether you can find it. Perhaps you saved a file in the wrong folder by accident. Also, check the spelling of the filename. Maybe your fingers weren’t on the home row when you typed the filename, so instead of River City.pptx, you saved the file as Eucwe Xurt.pptx. I hate it when that happens. If all else fails, you can use Windows’ built-in Search feature. For Windows XP,  click the Start button and then choose Search and follow the instructions that appear in the Search Results window. If you’re using Vista, you can simply type some or all of the filename in the Instant Search box that  appears in the Start menu.

            

            
               [image: ]
            

            	The fastest way to open a file from the Open dialog box is to double-click  the file. This spares you from having to click the file once and then click OK. Double-clicking also exercises the fast-twitch muscles in your index finger.

            PowerPoint keeps track of the last nine files that you’ve opened and displays them on the File menu. To open a file that you recently opened, click the File menu and inspect the list of files on the right side of the menu. If the file that you want is in the list, click it to open it.

         

         
            Closing a Presentation

            Having finished and saved your presentation, you have come to the time to close it. Closing a presentation is kind of like gathering your papers, putting them neatly in a file folder, and returning the folder to its proper file drawer. The presentation disappears from your computer screen. Don’t worry: It’s tucked safely away on your hard drive where you can get to it later if you need to.

            To close a file, click the Close button that appears at the top right of the PowerPoint window. Alternatively, you can click the Office button and then choose Close, or use the keyboard shortcut Ctrl+W. But clicking the Close button is the easiest way to close a file.

            

            
               [image: ]
            

            	You don’t have to close a file before exiting PowerPoint. If you exit PowerPoint without closing a file, PowerPoint graciously closes the file for you. The only reason that you might want to close a file is that you want to work on a different file and you don’t want to keep both files open at the same time.

            If you’ve made changes since the last time you saved the file, PowerPoint offers to save the changes for you. Click Yes to save the file before closing or click No to abandon any changes that you’ve made to the file.

            If you close all the open PowerPoint presentations, you might discover that most of the PowerPoint commands have been rendered useless (they are grayed on the menu). Fear not. If you open a presentation or create a new one, the commands return to life.

         

         
            Exiting PowerPoint

            Had enough excitement for one day? Use any of these techniques to shut PowerPoint down:

            
               	[image: bullet]	Click the Office button and then click the Exit PowerPoint button.

               	[image: bullet]	Click the X box at the top-right corner of the PowerPoint window.

               	[image: bullet]	Press Alt+F4.

            

            Bam! PowerPoint is history.

            You should know a couple things about exiting PowerPoint (or any application):

            
               	[image: bullet]	PowerPoint doesn’t let you abandon ship without first considering whether you want to save your work. If you’ve made changes to any  presentation files and haven’t saved them, PowerPoint offers to save  the files for you. Lean over and plant a fat kiss right in the middle of  your monitor — PowerPoint just saved you your job.

            

            

            
               [image: ]
            

            
               	[image: bullet]	Never, never, never, ever, never turn off your computer while PowerPoint or any other program is running. Bad! Always exit PowerPoint and all other programs that are running before you turn off your computer.

            

         

      

      

   
      
         Chapter 2

         Editing Slides

         In This Chapter

         
            [image: bullet]	Moving around in a presentation

            [image: bullet]	Working with objects and editing text

            [image: bullet]	Undoing a mistake and deleting slides

            [image: bullet]	Finding and replacing text

            [image: bullet]	Rearranging slides

         

         
            If you’re like Mary Poppins (“Practically Perfect in Every Way”), you can skip this chapter. Perfect people never make mistakes, so everything that they type in PowerPoint comes out right the first time. They never have to press Backspace to erase something they typed incorrectly, or go back and insert a line to make a point they left out, or rearrange their slides because they didn’t add them in the right order to begin with.

         If you’re more like Jane (“Rather Inclined to Giggle; Doesn’t Put Things Away”) or Michael (“Extremely Stubborn and Suspicious”), you probably make mistakes along the way. This chapter shows you how to go back and correct those mistakes.

         Reviewing your work and correcting it if necessary is called editing. It’s not a fun job, but it has to be done. A spoonful of sugar usually helps.

         This chapter focuses mostly on editing text objects. Many of the techniques apply to editing other types of objects, such as clip art pictures or drawn shapes. For more information about editing other types of objects, see Part III.

         
            Moving from Slide to Slide

            The most common way to move in a PowerPoint presentation is to press the Page Down and Page Up keys:

            
               	[image: bullet]	Page Down: Press Page Down to move forward to the next slide in your presentation.

               	[image: bullet]	Page Up: Press Page Up to move backward to the preceding slide in your presentation.

            

            You can also use the vertical scroll bar on the right side of the window to navigate through your presentation:

            
               	[image: bullet]	Double-headed arrows: You can move forward or backward through your presentation one slide at a time by clicking the double-headed arrows at the bottom of the vertical scroll bar.

               	[image: bullet]	Single-headed arrows: You can also scroll forward or backward through your presentation by clicking and holding the single-headed arrow at the top or bottom of the vertical scroll bar. (Note that if the zoom factor is set so that a single slide is visible in the presentation window, clicking the single-headed arrows moves to the next or previous slide.)

               	[image: bullet]	Scroll box: Another way to move quickly from slide to slide is to click the scroll box within the vertical scroll bar and drag it up or down by left-clicking. When you drag the box, a little ToolTip pops up next to the slide bar to tell you which slide will be displayed if you release the button at that position.

            

         

         
            Working with Objects

            
               
                  In the beginning, the User created a slide. And the slide was formless and void, without meaning or content. And the User said, “Let there be a Text Object.” And there was a Text Object. And there was evening and there was morning, one day. Then the User said, “Let there be a Picture Object.” And there was a Picture Object. And there was evening and there was morning, a second day. This continued for forty days and forty nights, until there were forty objects on the slide, each after its own kind. And the User was laughed out of the auditorium by the audience who could not read the slide.

            

            I present this charming little parable solely to make the point that PowerPoint slides are nothing without objects. Objects are items — such as text, pictures, and charts — that give meaning and content to otherwise formless and empty slides. When it comes to objects, however, sometimes less is more. Don’t overdo it by cluttering your slides with so many objects that the main point of the slide is obscured.

            Most of the objects on your slides are text objects, which let you type text on your slides. For more information about working with text objects, see Chapter 8.

            Every slide has a slide layout that consists of one or more placeholders. A placeholder is simply an area on a slide that is reserved for text, clip art, a graph, or some other type of object. For example, a slide that uses the Title layout has two placeholders for text objects: one for the title and the other for the subtitle. You use the Slide Layout task pane to select the layout when you create new slides. You can change the layout later, and you can add more objects to the slide. You can also delete, move, or resize objects if you want. For more information about slide layouts, see Chapter 1.

            You can add many different types of objects, such as clip art, charts, graphs, shapes, and so on. You can add additional objects to your slide with one of the tools that appears on the Drawing toolbar at the bottom of the screen or by using the icons that appear in the center of slides created using the Content layouts. For more information about adding additional objects to your slides, see Chapters 12 through 17.

            Each object occupies a rectangular region on the slide. The contents of the object might or might not visually fill the rectangular region, but you can see the outline of the object when you select it (see the section “Selecting objects,” later in this chapter).

            Objects can overlap. Usually, you don’t want them to, but sometimes doing so creates a jazzy effect. You may lay some text on top of some clip art, for example.

            
               Selecting objects

               Before you can edit anything on a slide, you have to select the object that contains whatever it is that you want to edit. For example, you can’t start typing away to edit text on-screen. Instead, you must first select the text object that contains the text you want to edit. Likewise, you must select other types of objects before you can edit their contents.

               Here are some guidelines to keep in mind when selecting objects:

               
                  	[image: bullet]	Text objects: To select a text object so that you can edit its text, move the insertion point over the text that you want to edit and then click. A rectangular box appears around the object, and a text insertion point appears so that you can start typing away.

                  	[image: bullet]	Non-text objects: Other types of objects work a little differently. Click an object, and the object is selected. The rectangular box appears around the object to let you know that you have hooked it. After you have hooked the object, you can drag it around the screen or change its size, but you can’t edit it. 

                  	[image: bullet]	Click and drag: Another way to select an object — or more than one object — is to use the insertion point to drag a rectangle around the objects that you want to select. Point to a location above and to the left of the object(s) that you want to select, and then click and drag the mouse down and to the right until the rectangle surrounds the objects. When you release the button, all the objects within the rectangle are selected.

                  	[image: bullet]	The Tab key: Also, you can press the Tab key to select objects. Press Tab once to select the first object on the slide. Press Tab again to select the next object. Keep pressing Tab until the object that you want is selected.

                  	[image: bullet]	The Ctrl key: You can select more than one object by selecting the first object and then holding down the Ctrl key while clicking to select additional objects.

               

               Pressing Tab to select objects is handy when you can’t easily point to the object that you want to select. This problem can happen if the object that you want is buried underneath another object or if the object is empty or otherwise invisible and you’re not sure of its location.

            

            
               Resizing or moving an object

               When you select an object, an outline box appears around it. If you look closely at the box, you can see that it has love handles, one on each corner and one in the middle of each edge. You can use these love handles to adjust the size of an object. You can also grab the box between the love handles to move the object on the slide.

               In addition, for many types of objects, a green dot called the rotate handle appears, floating above the object. You can rotate the object by grabbing this handle and dragging it around in a circle. (Not all types of objects can be rotated, however. For example, you can’t rotate charts.)

               To change the size of an object, click the object to select it and then grab one of the love handles by clicking. Hold down the mouse button and then move the mouse to change the object’s size.

               The various handles on an object give you different ways to change the object’s size:

               
                  	[image: bullet]	The handles at the corners allow you to change both the height and width of the object.

                  	[image: bullet]	The handles on the top and bottom edges allow you to change just the object’s height.

                  	[image: bullet]	The handles on the right and left edges change just the width of the object.

               

               If you hold down the Ctrl key while you drag one of the love handles, the object stays centered at its current position on the slide. Try it to see what I mean. Also, try holding down the Shift key while you drag an object by using one of the corner love handles. This combination maintains the object’s proportions when you resize it.

               Changing a text object’s size doesn’t change the size of the text in the object; it changes only the size of the frame that contains the text. Changing the width of a text object is equivalent to changing margins in a word processor: It makes the text lines wider or narrower. To change the size of the text within a text object, you must change the font size. For more information, see Chapter 8.

               To move an object, click anywhere in the outline box — except on a love handle — and then drag the object to its new locale.

               The outline box can be hard to see if you have a fancy background on your slides. If you select an object and have trouble seeing the outline box, try squinting or cleaning your monitor screen. Or, in severe weather, try selecting the View tab on the Ribbon and then choosing one of the Color/Grayscale options:

               
                  	[image: bullet]	Color: Displays slides in full color

                  	[image: bullet]	Grayscale: Displays colors as shades of gray

                  	[image: bullet]	Pure Black and White: Shows the slides in black and white

               

               Viewing the slide in Grayscale or Pure Black and White might make the love handles easier to spot. To switch back to full-color view, click Back to Color View.

            

         

         
            Editing a Text Object

            When you select a text object for editing, PowerPoint transforms into a baby word processor so you can edit the text. Note that PowerPoint automatically wraps text so that you don’t have to press Enter at the end of every line. Press Enter only when you want to begin a new paragraph.

            Text in a PowerPoint presentation is usually formatted with a bullet character at the beginning of each paragraph. The default bullet character depends on the theme you’ve applied to the slide. But if you don’t like the bullet provided by the theme, you can change it to just about any shape that you can imagine. The point to remember here is that the bullet character is a part of the paragraph format, and not a character that you have to type in your text.

            Most word-processing software enables you to switch between Insert mode and Typeover mode by pressing the Insert key on the right side of your keyboard. In Insert mode, any characters that you type are inserted at the insertion point (the blinking vertical line that appears within the text.) In Typeover mode, each character that you type replaces the character at the insertion point. However, PowerPoint always works in Insert mode, so any text that you type is inserted at the insertion point. Pressing Insert has no effect on the way text is typed.

            You can move around within a text object by pressing the arrow keys or by using the mouse. You can also use the End and Home keys to take the insertion point to the start or end of the line that you’re on. Additionally, you can use the arrow keys in combination with the Ctrl key to move around even faster. For example, press the Ctrl key and the left- or right-arrow key to move left or right an entire word at a time.

            You delete text by pressing the Delete or Backspace key. To delete from the insertion point to the start or end of a word, use the Ctrl key along with the Delete or Backspace key. If you first select a block of text, the Delete and Backspace keys delete the entire selection. (The next section, “Selecting Text,” has some tips for selecting text.)

         

         
            Selecting Text

            Some text-editing operations — such as amputations and transplants — require that you first select the text on which you want to operate. The  following list shows you the methods for selecting blocks of text:

            
               	[image: bullet]	When you use the keyboard, hold down the Shift key while you press any of the arrow keys to move the insertion point.

               	[image: bullet]	When you use the mouse, point to the beginning of the text that you want to mark and then click and drag over the text. Release the mouse button when you reach the end of the text that you want to select.

            

            PowerPoint has an automatic word-selection option that tries to guess when you intend to select an entire word. If you use the mouse to select a block of text that spans the space between two words, you notice that the selected text jumps to include entire words while you move the mouse. If you don’t like this feature, you can disable it by clicking the PowerPoint Options button on the Office menu. Click the Advanced tab and then deselect the When Selecting, Automatically Select Entire Word check box.

            You can use the following tricks to select different amounts of text:

            
               	[image: bullet]	A single word: To select a single word, point the insertion point anywhere in the word and double-click.

               	[image: bullet]	An entire paragraph: To select an entire paragraph, point the insertion point anywhere in the paragraph and triple-click.

            

            After you have selected text, you can edit it in the following ways:

            
               	[image: bullet]	Delete text: To delete the entire block of text that you’ve selected, press Delete or Backspace.

               	[image: bullet]	Replace text: To replace an entire block of text, select it and then begin typing. The selected block vanishes and is replaced by the text that you’re typing.

               	[image: bullet]	Cut, Copy, and Paste: You can use the Cut, Copy, and Paste commands from the Clipboard group with selected text blocks. The following section describes these commands.

            

         

         
            Using Cut, Copy, and Paste

            Like any good Windows program, PowerPoint uses the standard Cut, Copy, and Paste commands. These commands work on text that you’ve selected, or if you’ve selected an entire object, the commands work on the object itself. In other words, you can use the Cut, Copy, and Paste commands with bits of text or with entire objects.

            Cut, Copy, and Paste all work with one of the greatest mysteries of Windows — the Clipboard. The Clipboard is where Windows stashes stuff so that you can get to it later. The Cut and Copy commands add stuff to the Clipboard, and the Paste command copies stuff from the clipboard to your presentation.

            The Ribbon buttons for working with the Clipboard are found in the Clipboard group of the Home tab. Three of the four buttons in this section are for working with the Clipboard:

            
               [image: ]
            

[image: minitable]

            Notice that the Paste button includes a drop-down arrow. If you click the Clipboard icon, the object you most recently cut or copied is pasted. If you click the arrow, a menu with additional pasting options appears.

            The keyboard shortcuts for Cut, Copy, and Paste are the same as they are  for other Windows programs: Ctrl+X for Cut, Ctrl+C for Copy, and Ctrl+V for Paste. Because these three keyboard shortcuts work in virtually all Windows programs, memorizing them pays off.

            You can use the Copy and Paste commands together to duplicate information. If you want to repeat an entire sentence, for example, copy the sentence to the Clipboard, place the insertion point where you want the sentence duplicated, and then use the Paste command. Or if you want to create a slide that has five identical rectangles on it, start by drawing one rectangle. Then copy the rectangle to the Clipboard and paste it to the slide four times. You end up with five rectangles — the original one you drew, plus the four copies that you pasted.

            PowerPoint has a Duplicate command you can use to quickly create copies of objects. First, select the object you want to duplicate. Then, press Ctrl+D to create a duplicate of the object. You’ll probably need to move the duplicate object to its correct location.

            An even easier way to duplicate an object is to hold down the Ctrl key, click, and then drag the object to a new location on the slide. After you release the mouse button, a duplicate copy of the object is created.

            If you want to blow away an entire object permanently, select it and then press Delete or Backspace. This step removes the object from the slide but doesn’t copy it to the Clipboard. It’s gone forever. Well, sort of — you can still get it back by using the Undo command, but only if you act fast. See the section, “Oops! I Didn’t Mean It (The Marvelous Undo Command)” for more information.

            To include the same object on each of your slides, you can use a better method than copying and pasting: Add the object to the Slide Master, which governs the format of all the slides in a presentation (see Chapter 11).

         

         
            Using the Clipboard Task Pane

            The Clipboard task pane lets you gather up to 24 items of text or graphics from any Office program and then selectively paste them into your presentation. To summon the Clipboard task pane, click the Dialog Box Launcher  in the Home tab on the Ribbon at the bottom right of the Clipboard group. Then, the Clipboard task pane appears, as shown in Figure 2-1. Here, you  can see the Clipboard task pane at the left side of the PowerPoint window, with several objects held in the clipboard.

            
               
                  
                     
                        	
                           
                              Figure 2-1: The Clipboard task pane.

                        
                        	
                           [image: Figure 2-1: The Clipboard task pane.]
                        
                     

                  
               

            

            To paste an item from the Clipboard task pane, simply click the item you want to insert.

         

         
            Oops! I Didn’t Mean It (The  Marvelous Undo Command)

            Made a mistake? Don’t panic. Use the Undo command. Undo is your safety net. If you mess up, Undo can save the day.

            You have two ways to undo a mistake:

            
               	[image: bullet]	Click the Undo button in the Quick Access toolbar.

               	[image: bullet]	Press Ctrl+Z.

            

            Undo reverses whatever you did last. If you deleted text, Undo adds it back.  If you typed text, Undo deletes it. If you moved an object, Undo puts it back where it was. You get the idea.

            Undo is such a useful command that committing the Ctrl+Z keyboard shortcut to memory is a good idea. If you want, think of the word Zip! to help you remember how to zip away your mistakes.

            Undo remembers up to 20 of your most recent actions. You can undo each action one at a time by repeatedly using the Undo command. Or you can click the down arrow next to the Undo button on the Quick Access Toolbar and then choose the actions you want to undo from the list that appears. However, as a general rule, you should correct your mistakes as soon as possible. If you make a mistake, feel free to curse, kick something, or fall on the floor in a screaming tantrum if you must, but don’t do anything else on your computer! If you use the Undo command immediately, you can reverse your mistake and get on with your life.

            PowerPoint also offers a Redo command, which is sort of like an Undo for Undo. In other words, if you undo what you thought was a mistake by using the Undo command and then decide that it wasn’t a mistake after all, you can use the Redo command. Here are two ways to use the Redo command:

            
               	[image: bullet]	Click the Redo button on the Quick Access toolbar.

               	[image: bullet]	Press Ctrl+Y.

            

            Note that if the last action you performed wasn’t an Undo command, the Redo button is replaced by a Repeat button. You can click the Repeat button to repeat the last command.

         

         
            Deleting a Slide

            Want to delete an entire slide? No problem. Simply move to the slide that you want to delete and click the Delete button in the Slides group of the Home tab on the Ribbon. Zowie! The slide is history.

            Another way to delete a slide is to click the miniature of the slide in the Slide Preview pane (on the left side of the screen) and then press the Delete key or the Backspace key.

            Deleted the wrong slide, eh? No problem. Just press Ctrl+Z or click the Undo button to restore the slide.

         

         
            Duplicating a Slide

            PowerPoint sports a Duplicate Slide command that lets you duplicate an entire slide; text, formatting, and everything else included. That way, after you toil over a slide for hours to get its formatting just right, you can create a duplicate to use as the basis for another slide.

            To duplicate a slide — or slides — select the slide(s) you want to duplicate. Then open the Home tab on the Ribbon, click the arrow at the bottom of the Add Slide button in the Slides group, and choose the Duplicate Selected Slides button. A duplicate of the slide is inserted into your presentation.

            If you’re a keyboard shortcut fanatic, all you have to do is select the slide that you want to duplicate in the Slides pane (located on the left side of the screen) and then press Ctrl+D.

         

         
            Finding Text

            You know that buried somewhere in that 60-slide presentation is a slide that lists the options available on the Vertical Snarfblat, but where is it? This sounds like a job for the PowerPoint Find command!

            The Find command can find text buried in any text object on any slide. These steps show you the procedure for using the Find command:

            
               	
                  1.	
                  Think of what you want to find.

               		
                  Snarfblat will suffice for this example.

               	

            

            
               [image: ]
            

            
               	
                  2.	
                  Click the Find button in the Editing group of the Home tab (as shown in the margin). Or use the keyboard shortcut Ctrl+F.

               		The Find dialog box appears, as shown in Figure 2-2, which contains the secrets of the Find command.

            

            
               
                  
                     
                        	
                           
                              Figure 2-2: The Find dialog box.

                        
                        	
                           [image: Figure 2-2: The Find dialog box.]
                        
                     

                  
               

            

            
               	
                  3.	
                  Type the text that you want to find.

               		It displays in the Find What box.

               	
                  4.	
                  Press Enter.

               		Or click the Find Next button. Either way, the search begins.

            

            If the text that you type is located anywhere in the presentation, the Find command zips you to the slide that contains the text and highlights the text. You can then edit the text object or search for the next occurrence of the text within your presentation. If you edit the text, the Find dialog box stays on-screen to make it easy to continue your quest.

            Here are some facts to keep in mind when using the Find command:

            
               	[image: bullet]	Find the next occurrence: To find the next occurrence of the same text, press Enter or click the Find Next button again.

               	[image: bullet]	Edit the text: To edit the text you found, click the text object. The Find dialog box remains on-screen. To continue searching, click the Find Next button again.

               	[image: bullet]	Start anywhere: You don’t have to be at the beginning of your presentation to search the entire presentation. When PowerPoint reaches the end of the presentation, it automatically picks up the search at the beginning and continues back to the point at which you started the search.

               	[image: bullet]	Give up: You might receive the following message:

            

            

            PowerPoint has finished searching the presentation. The search item wasn’t found.

            
               		This message means that PowerPoint has given up. The text that you’re looking for just isn’t anywhere in the presentation. Maybe you spelled it wrong, or maybe you didn’t have a slide about Snarfblats after all.

               	[image: bullet]	Match case: If the right mix of uppercase and lowercase letters is important to you, select the Match Case check box before beginning the search. This option is handy when you have, for example, a presentation about Mr. Smith the Blacksmith.

               	[image: bullet]	Find whole words: Use the Find Whole Words Only check box to find your text only when it appears as a whole word. If you want to find the slide on which you discuss Smitty the Blacksmith’s mitt, for example, type mitt for the Find What text and select the Find Whole Words Only check box. That way, the Find command looks for mitt as a separate word. It doesn’t stop to show you the mitt in Smitty.

               	[image: bullet]	Replace text: If you find the text that you’re looking for and decide that you want to replace it with something else, click the Replace button. This step changes the Find dialog box to the Replace dialog box, which is explained in the following section.

               	[image: bullet]	Close the Find dialog box: To make the Find dialog box go away, click the Close button or press Esc.

            

         

         
            Replacing Text

            Suppose that the Rent-a-Nerd company decides to switch to athletic consulting, so it wants to change the name of its company to Rent-a-Jock. Easy. Just use the handy Replace command to change all occurrences of the word Nerd to Jock. The following steps show you how:

            
               	
                  1.	
                  Click the Replace button (found in the Editing group on the Home tab on the Ribbon) or use the keyboard shortcut Ctrl+H.

               		The Replace dialog box, as shown in Figure 2-3, appears.

            

            
               
                  
                     
                        	
                           
                              Figure 2-3: The Replace dialog box.

                        
                        	
                           [image: Figure 2-3: The Replace dialog box.]
                        
                     

                  
               

            

            
               	
                  2.	
                  In the Find What box, type the text that you want to find.

               		Enter the text that you want to replace with something else (Nerd, in this example).

               	
                  3.	
                  Type the replacement text in the Replace With box.

               		Enter the text you want to use to replace the text that you typed in the Find What box (Jock, in this example).

               	
                  4.	
                  Click the Find Next button.

               		PowerPoint finds the first occurrence of the text.

               	
                  5.	
                  Click the Replace button to replace the text.

               		Read the text first to make sure that it found what you’re looking for.

               	
                  6.	
                  Repeat the Find Next and Replace sequence until you’re finished.

               		Click Find Next to find the next occurrence, click Replace to replace it, and so on. Keep going until you finish.

            

            If you’re absolutely positive that you want to replace all occurrences of your Find What text with the Replace With text, click the Replace All button. This step dispenses with the Find Next and Replace cycle. The only problem is that you’re bound to find at least one spot where you didn’t want the replacement to occur. Replacing the word mitt with glove, for example, results in Sglovey rather than Smitty. Don’t forget that you can also use the Find Whole Words Only option to find and replace text only if it appears as an entire word.

            If you totally mess up your presentation by clicking Replace All, you can use the Undo command to restore sanity to your presentation.

         

         
            Rearranging Your Slides  in Slide Sorter View

            Normal View is the view that you normally work in to edit your slides, move things around, add text or graphics, and so on. However, Normal View has one serious limitation: It doesn’t give you a big picture of your presentation. You can see the details of only one slide at a time, and the Slide Preview pane lets you see snapshots of only a few slides. To see an overall view of your presentation, you need to work in Slide Sorter View.

            You can switch to Slide Sorter View in two easy ways:

            
               	[image: bullet]	Click the Slide Sorter button at the right side of the status bar.

               	[image: bullet]	Select the View tab on the Ribbon and then click the Slide Sorter button in the Presentation Views group.

            

            The PowerPoint Slide Sorter View is shown in Figure 2-4.

            
               
                  
                     
                        	
                           
                              Figure 2-4: Slide Sorter View lets you see the big picture.

                        
                        	
                           [image: Figure 2-4: Slide Sorter View lets you see the big picture.]
                        
                     

                  
               

            

            The following list tells you how to rearrange, add, or delete slides from Slide Sorter View:

            
               	[image: bullet]	Move a slide: To move a slide, click and drag it to a new location. Point to the slide and then hold down the left mouse button. Drag the slide to its new location and release the button. PowerPoint adjusts the display to show the new arrangement of slides.

               	[image: bullet]	Delete a slide: To delete a slide, click the slide to select it and then press Delete or Backspace. This works only in Slide Sorter View.

               	[image: bullet]	Add a new slide: To add a new slide, click the slide that you want the new slide to follow and then click the New Slide button. The Slide Layout task pane appears so that you can select the layout for the new slide. To edit the contents of the slide, return to Slide or Outline View via the view buttons (located at the right side of the status bar) or the View tab on the Ribbon.

            

            If your presentation contains more slides than can fit on-screen at one time, you can use the scroll bars to scroll through the display. Or you can use  the zoom slider at the bottom right corner of the screen to make the slides smaller.

            Slide Sorter View might seem kind of dull and boring, but it’s also the place where you can add jazzy transitions, build effects, or add cool animation effects to your slides. For example, you can make your bullets fall from the top of the screen like bombs and switch from slide to slide by using strips, wipes, or blinds. Chapter 10 describes all this cool stuff.

         

      

      

   


End of sample




    To search for additional titles please go to 

    
    http://search.overdrive.com.   
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